School of Nursing & Midwifery house style

Contents
Introduction ...................................................................................................................................2
Key references ..................................................................................................................................2
Style manual for authors, editors and printers ........................................................................2
Dictionaries ....................................................................................................................................2
Spell checker .................................................................................................................................3
School author–date referencing guide ....................................................................................3
Writing guides...............................................................................................................................3
Grammar essentials ......................................................................................................................3
Flinders University web style guidelines ..................................................................................3
Using styles in Microsoft Word ..................................................................................................4
General style guidelines ..........................................................................................................4
Troublesome words ....................................................................................................................17
Appendix 1: School of Nursing & Midwifery style sheet example ...........................................21
Introduction

Many educational institutions and most publishers have a system for handling style issues (such as capitalisation, spelling, abbreviations, terminology and treatment of numbers) in printed and online materials. This system is called a house style. Using a house style increases consistency across documents, giving the materials developed by an institution a more professional presentation. It also decreases the amount of time a writer, keyboard operator or editor has to spend making new decisions or remembering previous decisions about style issues.

The house style of the School of Nursing & Midwifery should be used in the preparation of all written material in the School, including student study materials, web content, correspondence and marketing/publicity materials. Writers preparing manuscripts for publication will, of course, use the house style recommended by the publisher.

House styles are ‘living’ documents and should be added to and modified as language usage and needs change. Please send suggestions or questions regarding this document to the Flexible Education Unit: nursfeu@flinders.edu.au.

It is also useful to develop your own style sheet in which you record style and usage decisions (spelling, hyphenation, treatment of numbers, proper nouns and so on) made about a document or set of documents. If writing in a team it is beneficial to co-develop and share the style sheet to maintain consistency and reduce editing and revision time. A style sheet template is available for download in Microsoft Word format from the School of Nursing & Midwifery house style web page <http://flinders.edu.au/nursing/studentsandcourses/learningresourcessupport/house-style.cfm> and in Appendix 1. The latter has some sample entries. The style sheet may be hand- or computer-developed.

Key references

Described below are a number of references you may find useful when writing.

Style manual for authors, editors and printers

The School of Nursing & Midwifery, like many Australian universities and the public service, bases its house style on:


The latest edition of the Style manual should be consulted for publication planning as well as writing and editing decisions such as those regarding:

- grammar
- inclusive (non-discriminatory) language
- spelling
- capitalisation
- use of italics and bold type
- punctuation
- numbers and measurement.

Dictionaries

The preferred general dictionary is the most recent edition of the Macquarie dictionary, at the time of printing:

Yallop, C (ed.) 2005, Macquarie dictionary, 4th edn, Macquarie Library, North Ryde, NSW.

The preferred nursing dictionary is the most recent edition of Mosby’s dictionary of medicine, nursing and health professions, at the time of printing:

Harris, P, Nagy, S & Vardaxis, N 2009, Mosby’s dictionary of medicine, nursing and health professions, Australian and New Zealand 2nd edn, Elsevier-Mosby, Chatswood, NSW.
Spell checker

Your word processing spell checker can be a useful aid to spelling and word usage, but do not rely on it.

**Hint**

Set your word processing spell checker to English (Australian): in Microsoft Word, go to the menu and select Tools > Language > Set Language. Scroll down to ‘English (Australia)’ and click on it, then click OK.

School author–date referencing guide

The School uses the author–date referencing system (sometimes called the Harvard system), of which there are numerous variations. The School endorses the School of Nursing & Midwifery author–date referencing guide, compiled initially by the Sturt Library and revised by the Flexible Education Unit (FEU). It is compatible with EndNote.

The guide should be used for referencing in all School documents and for all student teaching and study materials.

It is available for download from the School of Nursing & Midwifery referencing guide web page (flinders.edu.au/nursing/staffinformation/teaching-&-learning/school-of-nursing-&-midwifery-referencing-guide.cfm).

Writing guides

An excellent general Australian writing guide is:


It covers the rules of grammar, punctuation and spelling, is easy to understand, and includes many examples. It is available through the Sturt Library.

Grammar essentials

There are many grammar guides on the web. An easy-to-use one is The write site, developed by the University of Sydney. It comprises guides to grammar, sources (referencing and plagiarism) and structure and includes interactive learning exercises:


Flinders University web style guidelines

The University has published Style guidelines (<http://www.flinders.edu.au/online-communications/guidelines/web-content/style-guidelines.cfm>) that should be consulted when planning and writing web content. The guidelines include principles on writing for the web, designing for readability and accessibility, inclusive language and a glossary of general web terms.
Using styles in Microsoft Word

Using styles saves time and leads to better looking documents.

A style in Microsoft Word is a set combination of formatting characteristics that is named and stored for later use, and can have a keyboard shortcut. Styles are useful because they save formatting of individual words or paragraphs, they ensure consistent formatting within and between documents, and they allow you to change the formatting in one instance of the style and have all other instances in the document change automatically. For example:

- You can change the font size in the ‘normal’ style and the font size in all normal paragraphs will change, as will that of all other styles based on ‘normal’.
- You can change the font, its size, use of italics etc. in a heading level 1 and update the heading 1 style, and all other headings 1 in the document will change.

Some styles are built into Word, but you can create any number of additional styles. Once a style has been created and applied it can be changed and all instances in the document will also change. Some common styles you may wish to use or create are:

- title
- headings and subheadings
- quote
- reference
- bullet list
- table and figure captions
- header and footer.

Other benefits of using styles are the ability to create tables of contents automatically, and the use of the document map to navigate around a document quickly.

Styles are stored in templates. Word has a built-in ‘normal’ template. The Flexible Education Unit has developed templates for study plans and topic details. You can create other templates.

For more information about styles and templates see Microsoft Word help, or contact the FEU.

General style guidelines

The guidelines in this section are based on the Style manual and are useful as a quick reference, but please refer to the Style manual for further information.

Remember, one of the most important ‘rules’ in document preparation is consistency—when you’ve made an acceptable decision regarding usage, note it on your style sheet and stick to it!

**Abbreviations, acronyms and other shortened forms**

An abbreviation is a shortened form of a word or group of words containing the initial letter but **not the last** letter. A full stop is used at the end of the abbreviation. Generally, abbreviations should be avoided in discursive writing. Examples:

- Feb., fig., ed., cont.

Contractions use at least the first and last letters of the word. They do not use full stops. Examples:

- Mr, dept, Rd, figs, eds, Dr

Acronyms are made up of the initial letters of a group of words and are pronounced as one word. They do not use full stops. Examples:

- TAFE, ANZAC, Qantas, SATAC, AIDS, NATO

It is good practice to give the full form of the acronym when the term is first used in a document, followed by the acronym in brackets. Thereafter the acronym alone may be used. In a long document or on the web, you may need to use the full form more often to assist the reader.
Initialisms are made up of initial letters from a group of words. The letters are often individually pronounced. They do not use full stops:

RN, PO, RAA, ABC, ACT, NZ

**Academic honours and other postnominals**

When a staff member requires the written use of their name and full qualifications, the custom in the School is for the nursing or midwifery qualification to immediately follow the name, followed by academic honours (starting with the lowest degree) and professional associations. Each element is separated by a comma and is usually abbreviated:

Judith Hill, RN, BA, MA, PhD, FCNANZ, FRCNA

It is acceptable to leave out the undergraduate qualifications for a PhD holder—it is a matter of personal preference:

Judith Hill, RN, PhD, FCNANZ, FRCNA

**Academic position titles**

The senior academic position titles used within the School to refer to individual people are written as follows:

- Dean
- Associate Dean (Higher Degree Programs)
- Associate Dean (International)
- Associate Dean (Practice Development)
- Associate Dean (Research)
- Associate Dean (Teaching and Learning)
- Course Coordinator (Graduate Programs)
- Course Coordinator (Midwifery Programs)
- Course Coordinator (Undergraduate Programs)

Note, when referring to such positions in general, capitals should not be used:

In all cases, associate deans are responsible for …

It is often appropriate to use an academic title in association with academic postnominals:

Professor Judith Hill, RN, PhD, FCNANZ, FRCNA

For titles such as topic coordinator, which refer to many individuals, do not use capital letters:

Marie Alworth is the topic coordinator of NURS1111.

**Active voice**

Use the active voice unless there is a reason not to: it makes writing livelier and stronger. Use active verbs if possible. The passive voice is more distant and reserved:

✔️ Dr Jones taught pharmacology

❌ not Pharmacology was taught by Dr Jones

**Addresses and contact information**

The following describes the accepted format for addresses and contact information:

**Postal address**
School of Nursing & Midwifery
Flinders University
GPO Box 2100
Adelaide South Australia 5001
Australia

Telephone: +61 8 8201 3409
Fax: +61 8 8276 1602
Email: nusec@flinders.edu.au
School Office location
School of Nursing & Midwifery house style

Level 1, North Wing
Sturt Precinct [not Sturt Campus or Sturt Buildings]
Flinders University
Bedford Park SA 5042

When referring within a sentence to rooms or levels in a building, use lower case:

Dr Edith Bellew’s office is in room N127 on level 1.

**Ampersand**

The ampersand is generally used in three situations: in a text reference to joint authors, in the reference list or bibliography for publications with joint authors, and in the School’s name:

- The study was cited in Saunders & Hill (2010); the School of Nursing & Midwifery Crisp, J & Taylor, C (eds) 2009, *Potter & Perry’s fundamentals of nursing*, 3rd edn, Elsevier Australia, Chatswood.

Don’t otherwise use the ampersand in narrative text.

**Apostrophes**

The apostrophe (’) is generally used to show possession—something belongs to someone. With singular common nouns, the apostrophe is placed before the possessive s:

- the nurse’s stethoscope, the student’s exam, the faculty’s mission

With plural nouns ending in s, the apostrophe is placed at the end of the word:

- The students’ answers were all incorrect.
- The faculties’ budgets were approved.

Do not use an apostrophe within plural date spans or to indicate plural nouns:

- ✓ the 1970s, CDs, TVs, the 3Ds, FAQs
- X not the 1970’s, CD’s, TV’s, the 3D’s, FAQ’s

Another use of the apostrophe is in contractions, where the apostrophe shows a missing letter. These forms are not generally used in academic writing:

- shouldn’t, wouldn’t, can’t

**Its and it’s:** Some people are confused by these two terms. It’s is a contraction of it is; its shows possession.

- It’s time to leave; its pages are numbered incorrectly

To find out whether the apostrophe is required, substitute ‘it is’ and see if the sentence reads correctly: if it doesn’t, don’t use the apostrophe:

- X 😞 It is pages are numbered incorrectly [nonsense, so this usage cannot be it’s].
- ✓ 😊 Its pages are numbered correctly.

**Other tricky apostrophe uses**

**Time:**

- In one week’s time or three weeks’ time; not in one or three weeks time

**Plural letters of the alphabet:**

- Mind your p’s and q’s, but not your ps and qs.

**‘Do’s and don’ts’ or ‘dos and don’ts’:** The jury is out on this. A Google search on 17 December 2009 yielded 43,600 do’s and don’ts, and 10,300 dos and don’ts, so the do’s have it. The familiarity of the phrase makes either version acceptable to most readers, so choose one style and remain consistent within a document or series of documents.
Joint ownership:

√ Jim and Jan’s accountant

X not Jim’s and Jan’s accountant

Personal names ending in s:

Professor Jones’s lecture notes

It can be useful to note decisions you make about usage of the apostrophe on your style sheet.

Capitals

Capitalise proper nouns only (not all ‘important’ nouns). Nursing and midwifery, for example, are capitalised only when used as part of a proper noun such as a title or course:

School of Nursing & Midwifery, Association of Australian Midwives, Bachelor of Midwifery, but nursing schools in Australia

Capitalisation in referencing is determined by the referencing system’s style. Do not copy capitalisation from another referencing style or from a document itself: use the capitalisation from the referencing style of the publication you are writing for. The School of Nursing & Midwifery uses an author–date system, referred to above.

For capitalisation in headings see the section ‘Headings’.

Capitalisation of University academic and administrative units

The School has adopted the following capitalisation for shortened versions of academic and administrative units.

the School Office
the School [of Nursing & Midwifery]
the Library [Central, Sturt or other specific University library]
Sturt Precinct [not Sturt Campus or Sturt Buildings]
the Faculty [of Health Sciences]
the University

Date and page spans

Write 1999–2010 (not 1999–10) 2008–09 (not 2008–9), and pages 120–128 (not 120–8). Writing the span in full avoids ambiguity.

The dates in a span are separated by an en rule (see the section ‘Hyphens and dashes/rules’). Do not use the en rule with the words ‘from’ and ‘between’:

√ between 2009 and 2012, ; from 2009 to 2012

X not between 2009–2012, between 2009/12, or from 2009–12

Dates

Australian usage is day, day of month, month, year. No punctuation is used and do not use the form 25th, 22nd, 1st etc.:

√ 22 May 2009 and Tuesday 25 May 2009

Never put the day and year together:

X not January 22, 2010

Spell out days and months in full in running text:

The next board meeting will be held on Thursday 23 September 2010.

Do not use an apostrophe within plural date spans:

the 1990s, not the 1990’s
**School of Nursing & Midwifery house style**

**Degrees**
Capitals are used for the names of specific degrees but not when used generally:

Bachelor of Nursing *but* bachelors degree; Master of Midwifery *but* masters degree

The following are the abbreviations of common degrees:

- Bachelor of Arts—BA
- Bachelor of Health Sciences—BHlthSc
- Bachelor of Midwifery—BMid
- Bachelor of Nursing—BNg
- Graduate Certificate in Health—GradCertHlth
- Graduate Diploma in Mental Health Nursing—GradDipMentHlthNg
- Graduate Diploma in Nursing—GradDipNg
- Master of Arts—MA
- Master of Clinical Nursing—MClinNg
- Master of Midwifery—MMid
- Master of Nursing (Nurse Practitioner)—MNg(NPract)
- Master of Nursing—MNg
- Doctor of Education—EdD
- Doctor of Philosophy—PhD

If using the degree and the institution that granted the degree after a person’s name, the institution and degree can be abbreviated. You may need to check with an institution to see what their preferred abbreviation is. The form is:

BNg (Flin), MA (UniSA), PhD (Macq)

**Drug names**
Where possible use generic drug names, not proprietary ones. Do not capitalise generic drug names:

- ✓ paracetamol, metaclopromide, amoxycillin
- ❌ not Paracetamol, Metaclopromide, Amoxycillin
- ❌ and not Panadol, Maxolon, Amoxyl

**Ellipsis points**
Ellipsis points are used to mark the omission of a word or words from within a quote:

A nurse needs to be aware of ... severe penalties that may be incurred.

Ellipsis points consist of a single space followed by three unspaced full stops, and then a single space before the resumption of text. If the ellipsis occurs at the end of a sentence do not include another full stop, but if an exclamation mark or question mark is included in the quote, it should follow the ellipsis.

Do not use an ellipsis at the beginning of a quotation. If the quotation ends in the middle of a sentence, use an ellipsis to indicate that only part of the original sentence has been quoted:

‘Delirium ... is a potentially reversible cognitive impairment ...’ according to Crisp and Taylor (2009).

**Emphasis**
Use *italics* as a first preference for emphasis and **bold** as a second preference. Never *underline* or **CAPITALISE** for emphasis. **USE EMPHASIS SPARINGLY OR IT LOSES ITS IMPACT.**

**Flinders University name and logo**
The University is generally referred to as Flinders University. Do not use the name The Flinders University of South Australia, Flinders University Adelaide Australia or the acronym FUSA. The use of the single word ‘Flinders’ or ‘the University’ is acceptable in informal writing as long as the meaning is clear.
The University logo is available from http://www.flinders.edu.au/flinpress/logo.htm using a download application form. Do not just copy and paste the images from a web page.

**Foreign words and phrases**

Italicise foreign words and phrases unless they are included in the *Macquarie dictionary*. If they are in the dictionary, and thus ‘familiar’ to many readers, use roman type (that is, not italics or bold).

**Headings**

Headings divide text into logical sections and guide the reader through the material. They should be short and indicate the text that follows. Headings are hierarchical; that is, their level relates to their importance relative to other headings.

Headings may be differentiated by type size, font, spacing above and below the heading, and the use of bold and/or italics type. In the templates for Microsoft Office products, Heading 1 is the main heading and is larger than Heading 2, Heading 2 is larger than Heading 3 etc. Generally, the heading one level higher than the text is the same size as the text, with italics and/or bold added.

It is preferable to use no more than four levels of headings.

Each heading level should have the same treatment—if you’ve used Arial 14-point bold for a Heading 1, use that typeface for all Headings 1. The best way to achieve this is to use or allocate a style to each heading. If you wish to change the formatting of a heading, simply change the style and it will change all instances of the heading in the document.

For information about how to use styles see the section ‘Using styles in Microsoft Word’.

Headings should be in lower case except for the initial capital and where proper nouns are used. There is no punctuation at the end of a heading, except where the context requires it, such as with a question mark:

- First word: use a capital here
- Common noun: don’t use a capital here
- Proper noun: use a capital here

Grammar and usage

Do universities matter?

Flinders University style guides

Last, if there is a colon in the heading, the word directly after it does not have a capital unless it is a proper noun:

Conclusion: next steps for universities

**Hyphens and dashes/rules**

There are three main types of dashes—the hyphen (–), the en dash/rule (—) and the em dash/rule (——).

**Hyphens** are used to separate prefixes from words or to separate doubled-up vowels:

- post-traumatic, pre-eminent

Hyphens are also used in compound adjectival phrases:

- the well-known textbook, the 60-year-old man

There are no spaces before or after hyphens.

A hyphen is not used in such a phrase if the phrase is modified or in a comparative or superlative form:

- a very well known textbook; the best known textbook

Where the second word of a hyphenated phrase is missing, as in sets of two or more hyphenated terms that show ranges, use ‘hanging hyphens’:

- Write a 2000- to 2500-word essay; she was career- and family-focused; the study looked at 65- to 75-year-old women.

Please check the dictionary or *Style manual* regarding the hyphenation of specific words as there are disagreements in practice.
Remember to be consistent within each document or set of documents: decide upon your usage and note it on your style sheet (appendix 1).

**En dashes**, twice the length of hyphens, are used in spans of figures or distances and to show an association between words:

- pages 103–105, 2009–2010, the nursing–medicine research team

If the en dash separates single words or sets of numbers there is no space before or after it; if it separates more than one word it is ‘spaced’:

- a School of Nursing & Midwifery – University agreement

**Em dashes**, twice the length of en dashes, are used to mark an abrupt break in a sentence or to mark a parenthetical statement. There is no space before or after an em dash:

- Midwifery students are challenged by external factors—insurance confusion is one—as well as the curriculum.

**In Microsoft Word, create em and en dashes using shortcuts**

- en dash: Ctrl plus – (the minus sign on the numeric keypad)
- em dash: Ctrl plus Alt plus – (the minus sign on the numeric keypad)

Or use Insert > Symbol... > Special characters (tab), find the appropriate rule, click Insert.

**Inclusive language**

University policy encourages the use of inclusive language in all communications. Communications should reflect the diversity of the community and avoid stereotypical or insensitive references. Discriminatory language can alienate and offend readers and reflect poorly upon the School, the University and the writer. Please review the University’s ‘Equal opportunity’ website <http://www.flinders.edu.au/equal-opportunity/eo_unit_home.cfm>.

When referring to someone whose gender is not known, use the pronoun ‘their’ and not ‘his/her’, and ‘they’ and not ‘he/she’:

- One student left their backpack at the clinical venue.

**Legislation**

All legislation should be cited exactly:

- South Australia’s *Occupational Health, Safety and Welfare Act 1986* was cited in the student case.

  - The *Nursing and Midwifery Practice Act 2008* (SA) requires nursing and midwifery students to register with the nmbSA.

Please refer to the *Style manual* for additional information on citing legislation.

**Lists**

Bullet points should be used unless the list must be a sequence or a set order of steps (then use numbers). If another level of items is required, indent and use en rules as bullets.
A colon is used at the end of the lead-in phrase before the bullet points. Capitalise only proper nouns or complete sentences in a list. Do not punctuate the end of bullet points (unless they are complete sentences) except for the last bullet point, which has a full stop to note the list’s completion:

First-year nursing students are required to purchase:

• a watch with a second-hand
• approved uniforms
• low-heeled and closed-toed shoes
• a stethoscope.

Styles can be created in MS Word for different types of bullet.

**Numbers in text**

In discursive writing, use words for one through nine; use digits for all others:

Three lecturers and 14 students attended the conference.

But note that if a sentence begins with a number that is ten or greater, the word is written in full:

Fourteen students and three lecturers attended the conference.

Page numbers, units of measurement, time and section references should use figures:

Read chapter 9.

We travelled 148 km.

In text, numbers from 1000 to 9999 are rendered with no spaces; numbers from 10,000 upwards use a comma before each set of three digits:

1654, 8467, 1,000,000, 2,500,000

**Ordinal numbers**

Use words rather than numerals:

first-year students, not 1st-year students

**Parentheses/brackets**

**Parentheses** (rounded brackets) are used to enclose words or phrases that clarify, define or provide additional information within text:

The School of Nursing & Midwifery (at Flinders University) offers undergraduate and postgraduate courses.

Parentheses are also used for in-text citations or references:

The study (Jones 2010) showed the correlation between drink driving and fatalities.

**Square brackets** [...] are used to insert a clarification or further information within text quoted from another source:

Green and Brown (2010) asserted that 'The study [completed by Jones in July 2009] is the most recent one to look at the use of drugs in pregnancy'.

Do not use one set of parentheses inside another; instead, use a combination of em rules and parentheses:

The study—conducted at the Flinders Medical Centre in Adelaide (South Australia) over five years—proved the relationship between the drugs.

**Angle brackets** <...> are used to enclose email and web addresses in running text or in a reference list:

Please refer to the Anacondor website <www.anacondor.com> for information about snake venom.

Parallel construction

Parallel construction (or structure) refers to the use of the same grammatical form to refer to different elements in a list. A list may be in a run-on sentence or presented as bullet points.

Lack of parallel construction is a very common error that can make text difficult to understand. Consider:

\( \times \) All students should be familiar with the website ‘Academic Integrity at Flinders’, which contains:
- definitions of academic integrity
- gives tips on how to avoid plagiarism
- provides advice on how to avoid collusion.

\( \checkmark \) All students should be familiar with the website ‘Academic Integrity at Flinders’, which contains:
- definitions of academic integrity
- tips on how to avoid plagiarism
- advice on how to avoid collusion.

Quotation marks and quotations

Quotes, or quotation marks, are used in academic writing mainly to indicate technical or specialist terms on their first mention and around short direct quotations. Single quotes (‘…’) are preferred to double quotes (“…”):

The term ‘lordosis’ refers to a curvature in the lumbar region of the spine; ‘scoliosis’ refers to a lateral curvature.

Primary prevention in health care aims to ‘promote and maintain health by removing the precipitating … causes of ill health’ (Crisp & Taylor 2009, p. 91).

Double quotation marks are used within single quotation marks if what is being quoted itself contains a quotation:

Smith (2010) claims that ‘according to the Style manual, block quotations "are often introduced by a colon” and punctuation that is not part of the quotation should be placed outside the quotation’.

The Style manual discusses other uses of quotation marks.

If quotations are longer than about 30 words, they should be set out in an indented block and set in a smaller typeface. They are usually introduced by a colon and do not use quotation marks:

An essential feature of teaching practice in the School of Nursing & Midwifery is the placement of undergraduate nursing and midwifery students in a variety of clinical practice settings where they have the opportunity develop clinical skills and observe clinical, remedial and training practices. (Flinders University 2010)

Note: the reference is given after (outside) the final punctuation mark in a block quote.

Punctuation of quotations

If a punctuation mark at the end of an in-line quotation is not part of the quotation, place it outside the closing quotation mark:

Brown (2004) suggests, ‘clinical trials have only limited utility’, but the proposed project will demonstrate that this is not the case.

If a quotation is a whole sentence, thus ending in a full stop, place the closing punctuation after the closing quotation mark:

Miller (2006) noted, ‘Pulmonary contusions are the most common lung injury in blunt chest trauma’.

If the punctuation mark such as a question mark or exclamation mark is part of the quotation, place it inside the quotation mark:

Students often ask, ‘Why do I have to do clinical placement?’ but once they experience it they come to understand the reasons.
**Slash**
Also called an *oblique, solidus or forward slash*. The slash can be used in web addresses (http://...), to show alternatives (yes/no, male/female) or as a substitute for *per or an* (70 km/h). There are no spaces between the slash and associated text.

**Spelling**
Use but don’t rely on the spell-checking tool in your software program. Your computer doesn’t know, for example, the difference between ‘their’ and ‘there’, ‘eye’ and ‘I’, or ‘four’ and ‘fore’ or ‘for’. Microsoft Word has an ‘Autocorrect Options’ feature that can be set to automatically correct mistypings you commonly make.

Go to **Tools > Autocorrect Options**. In the ‘Replace:’ field type in or paste your incorrect typing of any word. If an auto correction is already available the list will scroll down to show it. If it is not available, type the correct word in the ‘With:’ field. Click ‘Add’, then ‘OK’ if you do not wish to add more words.

It may also be useful to add the words you commonly misspell to the ‘Troublesome words’ section that follows.

Spellings in direct quotations should remain unchanged.
When using proper nouns, such as the World Health Organization, use the official spelling, even if some words are spelt differently in Australian English. It is useful to note unusual spellings on your style sheet.

**Australian English usage**
–*ise is a suffix in words such as *organise* and *recognise* in Australian usage. (American English will usually use –*ize for this suffix.) Thus, use –*ise, –*ising, –*isation and not –*ize, except where writing the official name of an organisation; for example, the World Health Organization, or when writing for a publisher that requires American usage. Always check the publisher’s style guide or author guidelines.

–*our is a suffix in words such as *labour, colour, harbour* in Australian usage. (American English will usually use –*or for this suffix.) Exceptions are proper nouns; for example, the Australian Labor Party, Victor Harbor, and when you are writing for a publisher that requires American usage. Always check the publisher’s style guide or author guidelines.
Spacing

Use only one space between words and sentences—do not use two spaces. Do not use double spacing (two returns) between paragraphs; instead, set paragraph spacing under ‘Format’ in Microsoft Word.

Go to Format > Paragraph... In Spacing > After: (or Before:), type in or use the down arrow to indicate the spacing you want to use. Click OK.

In a ‘normal’ paragraph that is Verdana 9-point font, or Times New Roman 11-point font, for example, 6 points would be an appropriate space after a paragraph. You can set the style in MS Word to have this paragraph spacing.

Line spacing is referred to by the term ‘leading’ (from the days of ‘hot metal’ type setting, when lines of type were separated by strips of lead). Leading can be set at about 3 points greater than the font size used in the normal or text style.

Go to Format > Paragraph... In Spacing > Line spacing:, choose At least:; in At: choose 3 points (3 pt) larger that the font size used for the style of the paragraph. Click ‘OK’.

Telephone/fax numbers

Where your intended readership may go beyond Australia’s borders, use the international format convention for telephone and fax numbers:

+61 8 8201 4444, +61 401 567 309

This is the preferred style for most School documents, including electronic documents.

For an intended audience that is based only in Australia the national format convention for telephone and fax numbers is acceptable:

08 8201 4444, 0401 567 309, 1800 378 901
Text alignment
The School preference is to align text to the left rather than justify it. This increases the readability of the text because word spacing is more even. Never use right justification unless text is being used in a design—even then, it should be used with great care.

Time of day
There are two different systems of expressing time of day: the 12-hour system and the 24-hour system.

In the 12-hour system a full stop (not a colon, as Microsoft Excel imposes) separates the hours from the minutes, and *am* and *pm* designate ‘before noon’ and ‘after noon’. Use 12 noon or 12 midnight, not the confusing 12 am or 12 pm. (Noon is considered to be *pm* and midnight, *am*.) Note: there is a single space between the figures and the *am* or *pm*:

11.45 am, 1.03 pm

In the 24-hour system midnight is 2400 hours and noon is 1200. The first two digits designate the hour and the last two digits designate the minutes:

0041 = 12.41 am, 2114 = 9.14 pm

Topic codes and titles
There is no space within topic codes. Do not use roman numerals in topic titles.

√ MIDW1008, Nursing Practice 2

X not MIDW 1008, Nursing Practice II

Typefaces and fonts
‘Typefaces’ and ‘fonts’ are now often used interchangeably. Microsoft Word and other software programs use the term ‘fonts’ to refer to ‘families’ of type characters (such as Times New Roman, Arial and Verdana) that have a set of sizes (for example, 8 points to 72 points).

**Bold typeface** may be used in headings or to add emphasis. Bold type should be used sparingly as its overuse lessens its impact. Italics is often a better choice for denoting emphasis within text.

*Italic typeface* is used for the titles of books and publications, technical terms if you wish to highlight their first use (using quotation marks is also acceptable), emphasis, foreign words and some headings.

Roman, or normal, typeface is used for most text as it is easy to read. It does not indicate any special emphasis.

For Study plans, Topic details and other study materials use Verdana 9-point for normal style.

Please consult the web page ‘Flinders branding’ <http://www.flinders.edu.au/staff/administration-and-services/flinders-branding.cfm> for information about usages for official correspondence:

The corporate font for use in all official Flinders correspondence is Helvetica 11 point, or where this is not available on your computer, Arial 11 point.

Underlining
Text should not be underlined unless it is a hyperlink. If emphasis is required use italic or bold.

Writing well
Some hints:

- Use plain English to improve the clarity and effectiveness of your communication. Avoid jargon, unnecessary words and clichés (avoid these like the plague!).
- Write in a style appropriate to your audience.
- Vary your sentence length and avoid large numbers of long, complex sentences.
- Where appropriate, use a short, simple word rather than a more obscure word.
- Use active rather than passive verbs.
• Use inclusive language.
• If writing informally for students, address your audience with the use of personal pronouns such as ‘you’ and ‘we’ rather than ‘the student’ or ‘lecturers’.
• If you can, put aside your work for a couple of days and then re-read and edit it.
Troublesome words

Please refer to the latest edition of the *Macquarie dictionary* for correct spellings. As a general rule, if a choice is given in the spelling of a word, use the first choice.

You may find it helpful to print this list and add your own troublesome words so that it is more useful in your work. It can also be useful to note unusual spellings on your style sheet (Appendix 1).

**A**

a/an—Use *a* if the following word begins with a consonant or what sounds like a consonant, e.g. a nurse, a pear, a hysterectomy, a European.

Use *an* if the following word begins with a vowel or what sounds like a vowel, e.g. an example, an underestimate of the problem, an hour.

Aboriginal/aboriginal—Capitalize when referring to Indigenous Australian people; use lower case when referring to non-Australian indigenous peoples. 'Aboriginal people' is preferred to 'Aboriginals' or 'Aborigines'. The term Aboriginal and Torres Straight Islanders includes all Indigenous Australians.

acknowledgment/acknowledgement—Either spelling is acceptable but be consistent in your document.

ad hoc (not italic)—for a specific purpose or impromptu, e.g. an ad hoc decision was made about the lunch order

Adobe Acrobat Reader—may also be referred to as Adobe Acrobat

Advice (noun)—an offered opinion

Advise (verb)—to give counsel

Adviser (noun)—is preferred to advisor

Advisory (adjective)—an advisory committee

Affect (verb)—to influence, produce a change in, pretend, have an effect on (compare 'effect')

aftercare

ageing

a lot—not alot

alumnus (male) or alumna (female)—singular

alumni—plural

am, pm—e.g. 9.30 pm. There is no space between the letters or a full stop after them. Note: it is 12 noon or 12 midnight—not the confusing 12 am or 12 pm.

analyse

anaesthesia

anaesthetic

antenatal

appendix—singular

appendixes or appendices—plural. Either spelling is acceptable but be consistent in your document.

Asia–Pacific—separated by an en rule

associate professor—Capitalise only when referring to an individual, e.g. Associate Professor Pauline Glover; in subsequent uses in the text, it can be abbreviated, e.g. Assoc. Prof. Glover.

audiovisual

aural—related to hearing; oral—related to the mouth or speaking

**B**

Bachelor of Education, BEd; Bachelor of Nursing, BNg (no full stops, no space)

bachelors degree—not bachelor’s degree. Use lower case and no apostrophe.

behaviour

benefited

biannual—twice yearly

biennial—every two years

breastfeeding

budgeted

**C**

caesarean section

cancelled

caregiver

careworker

case study

caseworker

catalogue

CD-ROM (all caps)—compact disc read-only memory

childbirth

client-focused

clinical learning contract—use lower case

childbirth

childcare

cm—centimetre. There is a space after the number and no full stop; more than one centimetre does not end in *s*, e.g. 34 cm (not 34 cms).

coauteur

colour, not color

commitment

comorbidity—not co-morbidity

computer-aided

contraindications—not contra-indications

convener—not convenor

cooperate

coordinate, coordinator

co-organise
School of Nursing & Midwifery house style

counsellor—one who counsels
course coordinator—Capitalise only when referring to a specific individual’s title, e.g. Dr Paul Bennett, Course Coordinator (Postgraduate Programs).
could have—not could of
coursework
coworker
criteria—plural; commonly used incorrectly as a singular noun; criterion—singular
criticise—not criticize

curriculum—singular; curricula—plural
curriculum vitae—singular; curricula vitae or curriculum vitaea—plural
CV—abbreviation of curriculum vitae

data—now generally used as both the singular and plural form but datum may be used for the singular
database
date format—The required format is 7 May 2010 or, if a day is included, Wednesday 7 May 2010 (no punctuation).
dean—Capitalise only when referring to a specific individual’s title, e.g. the Dean of the School of Nursing & Midwifery.
decision-making—(adjective) e.g. decision-making skill
dependant (noun)—one who depends on another dependent (adjective)—dependent upon, contingent, subordinate
different from—not different than/to
discussion forum
doctoral (adjective)
ddoctorate (noun)
the Dreaming, or Dreamings—use instead of Dreamtime

effect—(noun) a consequence; (verb) to bring about or make happen (compare ‘affect’)
e.g.—exempli gratia, for example. Avoid use except where space is an issue. If e.g. is used, a comma does not follow it.
email—not e-mail
enquiry/inquiry—often interchangeable; enquiry is a less formal query
enrol, enrolment
ensure/insure—interchangeable; be consistent in usage
eReadings—electronic readings available through the University Library; not e-Readings or e-readings
eReserve—not e-reserve or e-Reserve
et al.—et alii, and others (note full stop only after al.)
etc.—et cetera, and so on. Avoid using because it is often imprecise. No comma is used before etc. if it is the last item in a list, e.g. ‘Turn off your computer, printer etc. before leaving at night’.
evidence-based—Capitalise both words only in the title of a topic, e.g. Evidence-Based Nursing; otherwise, they should be lower case.

F

faculty—Capitalise only when referring to a specific faculty, e.g. the Faculty of Health.
FAN (all caps)—Flinders Authentication Name (initial caps)
fee-paying (adjective)—e.g. fee-paying student
field study
fieldwork; but field worker
first-year (adjective)—e.g. first-year students; but students in their first year
Flinders University—general use. The Flinders University of South Australia is used only in official legal documents. Flinders University, Adelaide, Australia should not be used except in the approved logo artwork.
FLO (all caps)—Flinders Learning Online (initial caps)
focus—singular; focuses—plural, also foci
focused—not focussed
foetal—not fetal
foreword—explains the purpose of or supports a work; not forward
forno—to refrain from, e.g. I forgo chocolate in order to lose weight (‘forego’ is to precede)
formula—singular; formulae—plural, also formulas forum—singular; forums—plural
fulfill—but fulfilled, fulfilling
full-time—always hyphenated

G

graduand—one who has qualified for a degree but it is yet to be conferred
graduate—one who has received a degree
graduate-entry (adjective)

H

handout
health care (noun); but healthcare workers, the healthcare sector (adjectival use)
health-related
home page—two words
honours/honours program/honours degree
HTML (all caps)—hypertext mark-up language
hyperlink

I

ibid.—ibidem, in the same work. Note the full stop at the end, and no italics.
i.e.—id est, that is. Use ‘that is’ in general writing.
If i.e. is used, a comma does not follow it.
If iFlinders—the University’s web portal
immunisation
in-depth (adjective)
indigenous/Indigenous—use capital only when referring to Australian Aboriginal and Torres Strait Islander peoples
in-house (adjective)
inquiry/enquiry—interchangeable. Enquiry is a less formal query. Be consistent in usage.
interactive
interdisciplinary
interrelated
internet
ISBN (all caps)—International Standard Book Number
ISSN (all caps)—International Standard Serial Number
it’s/its—It’s is a contraction of ‘it is’, e.g. ‘It’s time we left’; its is the possessive form of it, e.g. ‘Its length was 450 words’.

J
judgement—not judgment

K
Keynote (adjective)
kilometre—1000 metres; not kilometer (US); abbreviation: km, not kms
kilogram—1000 grams; also kilo (in informal writing only); abbreviation: kg, not kgs

L
library—Capitalise only when referring to one of the Flinders University libraries or when part of a proper noun, e.g. Sturt Library.
life cycle
lifelong
life span
lifestyle
lifetime
long-term (adjective)—e.g. our long-term plans
log in/log on (verb)—e.g. Log in to FLO to access the materials
login (noun)—e.g. the login page
LOTE (all caps)—acronym for ‘language other than English’, e.g. we should be aware of LOTE teaching strategies

M
marketed
Master of Arts (MA), Master of Midwifery (MMid), Master of Nursing (MNg)
masters degree, masters level—not master’s degree. Use lower case and no apostrophe.
media—referring to a means of communication such as radio or television; may be used as a collective singular noun, e.g. the media provides adequate coverage of current affairs
medium—singular; media—preferred plural, although mediums is sometimes used
meta-analysis
midsemester—e.g. midsemester break
midyear
multicultural
multidisciplinary

N
n.d.—no date; used in a reference list when the date is unknown
n.p.—no place; used in a reference list when the place of publication is unknown
neonatal
NESB (all caps)—acronym for ‘non-English speaking background’; it’s preferable to use the acronym LOTE
non-verbal
nucleus—singular, nuclei—plural

O
occurred/occurrence
off-campus (adjective)—e.g. an off-campus meeting; but when used in a predicative sense it should be ‘the meeting was held off campus’
offshore
on-campus (adjective)—e.g. an on-campus lecture; but when used in a predicative sense it should be ‘the lecture will be held on campus’
ongoing
online—not on-line

P, Q
paediatric/s—not pediatric/s
part-time—always hyphenated
PDF (all caps)—portable document format [files]
a peer review, but a peer-reviewed article per cent (not percent), percentage
PhD—Philosophiae Doctor, Doctor of Philosophy
phenomenon—singular, phenomena—plural
postgraduate
post-operative
post-mortem
postnatal
practice (noun)—e.g. my nursing practice
practise (verb)—e.g. I practise nursing
pre-eminent
pre-registration
prerequisite
preventive, not preventative
principal—a chief or head (noun); main, highest in rank (adjective)
School of Nursing & Midwifery house style

principle (noun)—code, truth, rule of conduct

proactive

problem-based (adjective)

professor—Capitalise only when referring to a particular individual, e.g. Professor Joan Cooper; in subsequent uses in the text, it can be abbreviated, e.g. Prof. Cooper.

proforma—a document that allows a procedure to be documented

program—not programme

pro rata

Readings—Capitalise and italicise when referring to a specific topic resource, e.g. the book of Readings for NURS3812; if used generally, use lower case and roman type, e.g. the readings for the topic.

re-establish

re-explain

résumé—to make the é, hold down Ctrl + single quote mark + e

S

the School—Capitalise only when referring to the School of Nursing & Midwifery at Flinders; otherwise, use lower case.

the School Office

School of Nursing & Midwifery—note the use of the ampersand rather than ‘and’

self-evaluation

sic—draws attention to an error in something that is copied from the original; used with a square bracket and italicised [sic]

sociocultural

socioeconomic

solution-focused

stationary (adjective)—fixed, still

stationery (noun)—writing materials

stimulus—singular, stimuli—plural

Study plan—Use initial capital and italics when referring to a specific topic resource, e.g. the Study plan for NURS2408; otherwise, use lower case and roman (i.e. not italics).

Sturt Precinct—not Sturt Campus or Sturt Buildings

subcommittee

subheading

subsection

T

targeted

teamwork

teleconference

textbook

thesis—singular, theses—plural

timetable

topic coordinator—Capitalise only when referring to a specific individual’s title, e.g. Ian Blackman, Topic Coordinator; otherwise use lower case, e.g. topic coordinators met to discuss the issue; the topic coordinator for NURS1408.

Topic details—Use initial capital and italics when referring to the booklet of that name; otherwise, use lower case and roman (topic details).

Torres Strait Islanders

trialled, trialling

U

United States, US—Use ‘United States’ or ‘United States of America’ (not simply America) when referring to the country; US may be used as an adjective, e.g. the US navy employs many nurses.

University—Capitalise only when referring to Flinders (e.g. the University is located in Bedford Park) or the title of another university (e.g. the University of Wollongong is one of seven universities that offer a nursing course).

up to date—e.g. we are up to date with the preparation of topics materials; hyphenate only when used as an adjective, e.g. an up-to-date resource

URL (all caps)—uniform resource locator, an internet address

usable

user-friendly

user name—not username

V

v., vs—versus, against; preferable to spell it out unless it’s a legal citation

vice-chancellor—Capitalise only when referring to a specific individual or position, e.g. Vice-Chancellor Michael Barber; the Vice-Chancellor of Flinders University

W

the web—referring to the World Wide Web

web page—not webpage

website—not web site

wellbeing

while—not whilst

workforce

world-class

worldwide

World Wide Web, WWW

X, Y, Z

X-ray

Year 12 etc.—note the capital I
Appendix 1: School of Nursing & Midwifery style sheet example

**Title:** The ABC of everything (journal article for an Oz journal)

**Authors:** Awesome & Flunk

**Development timeline:** Feb. to June 2010

**Date begun:** 18 Feb. **Date finished:**

**Other:** File sharing and audit trial negotiated: see emails of Jan. ‘10.

<table>
<thead>
<tr>
<th>ABCD</th>
<th>EFGH</th>
</tr>
</thead>
<tbody>
<tr>
<td>above-named</td>
<td>highly respected etc. (no hyphen)</td>
</tr>
<tr>
<td>benefited—one ‘t’</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IJKL</th>
<th>MNOP</th>
</tr>
</thead>
<tbody>
<tr>
<td>learnt not learned</td>
<td>narrow-mindedness</td>
</tr>
<tr>
<td>judgement</td>
<td>pre-modern</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>QRST</th>
<th>UVW XYZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>supersede</td>
<td>well off (adv), well-off ... (adj.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Numbers &amp; measures</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–9 spell out; &gt;9 use digits</td>
<td>-is- not –iz-</td>
</tr>
<tr>
<td>fourfold etc (no hyphen)</td>
<td>full caps for chapter headings</td>
</tr>
<tr>
<td>1000, 10,000</td>
<td>Dates: 22 June 1947, no punct.</td>
</tr>
<tr>
<td>kilometres (km) etc.</td>
<td>punct. after footnote ref, not before.</td>
</tr>
</tbody>
</table>

**Comments:** Fig captions below figs, table captions above.

---

1 A style sheet can be used to record decisions made or given (as in a journal’s author guidelines, for example) about usage within a document or series of documents. Hyphenation, capitalisation, unusual proper nouns, spelling conventions, number usage and much else can be recorded on a style sheet, which then becomes a valuable reference as a document is developed through drafts or with multiple authors. A ‘clean copy’ of the style sheet is available from the School of Nursing & Midwifery website at [http://flinders.edu.au/nursing/studentsandcourses/learningresourcesupport/house-style.cfm](http://flinders.edu.au/nursing/studentsandcourses/learningresourcesupport/house-style.cfm).